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QUICK START GUIDE 

MBRM UNIVERSAL Add-ins
®
 version 10.3 (32-bit and 64-bit) 

ALL USE SUBJECT TO LICENSE AND LIMITED WARRANTY (SEE LICENSE.PDF) 

The UNIVERSAL
™

 Add-ins are compatible with 

Excel (including the multi-threaded calculation / MTC feature), Access, 

VB.NET/Visual Basic/VBA, C/C++/C#, Java, Python, Fortran, etc. 

running on all major versions of Windows. 

 

UNIX (Solaris, Linux, AIX) static and shared libraries available. 

 

C/C++ source code license also available. 

 

This "quick start guide" (file README.PDF) is very useful as an initial roadmap of how to use 

our software.  You can refer back to it by either : 

 Clicking the shortcut "Quick Start Guide" in the "MBRM Universal Add-ins" program group 

(accessed via Windows' "Start" button).  The shortcuts can also be used to view the manuals, 

brochures, price list, discount schemes, order form, press extracts, client feedback, background article 

on risk management system development, Visual Basic and C/C++ examples etc. 

 Or, opening the file README.PDF (in the installation directory, e.g. C:\MBRM). 
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1. Installing MBRM Universal Add-ins 

The Universal Add-ins auto-install program will automatically install the Universal Add-ins, 

and can be rerun at any time to do a reinstall or repair (e.g. to refresh files that have been 

accidentally changed or deleted). The UNIVERSAL Add-ins® are compatible with Excel 

(including the multi-threaded calculation / MTC feature), Access, VB.NET/Visual 

Basic/VBA, C/C++/C#, Java, Python, Fortran, etc. running on all major versions of 

Windows.  It is recommended that the person installing the software should be logged on 

with a user name having local administrator (or Operator) privilege to ensure that all files 

and registry keys are created properly. 

2. Knowing Your Machine id 

The Universal Add-ins auto-install program will inform you of the unique MBRM "machine 

id" of your computer.  The machine id is a number, 6 digits or less.  Do not confuse the 

machine id returned by the Universal Add-ins with a "desk" or "serial" number allocated 

internally by your IT department. 

You can also get the MBRM machine id at any time, check the license status on the machine, 

enter new license or move the existing license by running the MBRM License Utility - 

MBRM_License_Utility.exe ( for 32-bit Universal Add-ins) or 

MBRM_License_Utility_x64.exe ( for 64-bit Universal Add-ins). 

Make a note of the machine id since you will need it when requesting your Universal Add-

ins license number (activation key).  The machine id would remain the same even if you 

switched the computer off, or reinstalled the Universal Add-ins on the same computer. 

When you load any of our add-ins in Excel [e.g. using the shortcuts in the "MBRM 

Universal Add-ins" program group (as described in section 4); or using the "long way" of 

opening the .XLM/.XLA/.XLL files (as described in section 5); or using Excel's Add-ins 

manager (as described in section 7)] the add-ins will quote the same machine id and ask you 

to enter a license number (activation key) to activate the Universal Add-ins.  Section 3 below 

will describe how to get the license number. Once the license number is entered, the add-in 

will not ask you for the license number again.   

If your machine id is negative or begins with a "T", this is a temporary machine id and 

could change every time you log on as a different user [which would require you to get a 

new license number].  To avoid this, you should log in with a user name having 

administrator (or Operator) privilege and then re-run the installation program. 

Useful Tip : Excel users should also note that once the Universal Add-ins are attached in 

Excel, the menu "MBRM" under Excel's "Add-ins" ribbon will display the "machine id" and 

confirm which of the Universal Add-ins are attached to Excel (and their version numbers). 

See section 4 for details. 

3. Getting your License Number (activation key) 

After you have installed the Universal Add-ins (steps 1 and 2 above), you will be prompted 

to enter a license number when you first try to use the Universal Add-ins.  Without a valid 

license number, the Universal Add-in functions will all return either 0 or the error value of 
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-99,999,999.9 (which could be displayed as -1E+8 if the column width is not wide enough to 

display the number in full).   

The only difference between the purchased and free trial versions of the Universal Add-ins is 

the validity period of the LICENSE NUMBER which we will provide.   If at the end of a 

trial you decide to purchase the add-ins, you can simply enter the new purchased license 

number and continue using the software without needing to reinstall.  This considerably 

easies the migration from a trial period to live trading. 

You can get purchased and trial license numbers from our MBRM Web Service : 

http://www.mbrm.com/asp 

 If you don't have an existing account on our MBRM Web Service, you can quickly 

register on-line by using the "New Users Register Here" box. 

 If you do have an existing account, but you don't know your password, you can request it 

by using the "Forgotten password" box. 

 

Once you log into the MBRM Web Service, you can : 

 

 Obtain both free trial and purchased license numbers by choosing the main menu options: 

     "License Administrator for FREE 30 Day Trial Requests" 

 or 

     "License Administrator for Purchased Software" 

 

 Manage your list of supported users by choosing the main menu option : 

     "Register the users to be covered by your Support Contract" 

 

 See a listing of your previous license requests by choosing the main menu option : 

     "Your Universal Add-ins License History" 

With this option, you can get a listing of all your previously issued license numbers. 

Indeed, it is a free asset tracking system which provides a record of where our software is 

installed in your organization.  

 

Note about alternative hardware protection devices : 

We believe our software based license number scheme offers many more advantages to our 

users than if we chose to use physical hardware protection devices (which are sometimes 

called "Dongles").  Most of these hardware devices require background "driver" software to 

be installed and left running on your machine even when you are not using the software.  

This can potentially complicate the maintenance, enhancement, compatibility and 

upgradeability of your machine.  Also, if a "Dongle" is lost, stolen or breaks down, it is 

much slower to get a replacement than the alternative of getting a new license number from 

our MBRM Web Service.  Using license numbers, it is also easier to enable parallel test 

running when moving machines. 

For full details on moving or de-installing our add-ins (purchased licenses), please use 

the following page : 

http://www.mbrm.com/deinstall8.shtml  

http://www.mbrm.com/deinstall8.shtml
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4. Attaching the Universal Add-ins in Excel 

If calling the Universal Add-ins from a programming language (e.g. Visual Basic, 

C/C++, Fortran or ActiveX/COM), please refer to sections 12 to 14 below. 

The easiest way to attach the Universal Add-ins in Excel (i.e. enable the add-in's functions to 

be accessed via Excel) is to use the shortcuts in the "MBRM Universal Add-ins" program 

group (accessed via Windows' "Start" button).  There is a separate shortcut for every add-in.  

Each shortcut will start Excel, attach the requested add-in, and also load the sample 

spreadsheet(s) for that add-in. 

Once the add-in is attached, you can then attach other Universal Add-ins (see section 5 

below) and/or load any of the sample spreadsheets supplied (see section 10 below for the 

actual file names). 

Security Setting in Excel : If the Universal Add-in does not appear to be attaching, it is 

likely that your Excel security setting is set too high and thus disables all third-party add-ins. 

To overcome this: 

If you are using Excel 2003 or older, lower the Macro Security Settings: 

1. On the "Tools" menu, click "Macro", then "Security...". 

2. On the "Security Level" tab, select "Medium", then click "OK". 

With this setting, the next time you attach (load) an Excel Add-in, Excel will prompt you 

that certain files have macros in them and you will be given the opportunity to enable the 

macros. 

When loading our files (at least our .xll/.xla files), you should select the option to enable 

macros because the Universal Add-ins need our macros in order to run. 

WARNING: as Medium security setting is lower than the default Excel security 

setting, to avoid attacks from malicious software, users on the computer in question 

must exercise extra caution when using Excel. They MUST NOT choose to enable 

macros in any file that they do not fully trust or 100% sure about its exact origin. 

If you are using Excel 2007 or newer, you can add your MBRM folder to Excel's Trusted 

Locations list: 

A trusted location is a folder from which files can be opened without being checked by 

Excel's Trust Center, and does not open in Protected View. 

1. Go to Excel’s Options dialog. 

2. Click "Trust Center". 

3. Click "Trust Center Settings". 

4. Click "Trusted Locations" in Trust Center. 

5. Click "Add New Location" button. 

6. Click Browse and locate your Universal Add-ins installation folder, select the 

folder (e.g. C:\MBRM), then click OK. 
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5. Alternative method of Attaching the Universal Add-ins using the .XLL/.XLA 

files 

As an alternative method to section 4 above, you can attach the Universal Add-ins by starting 

Excel and then loading the multi-threaded .XLL (or equivalent single-threaded .XLA) file for 

the desired add-in (e.g. UNIVOPT_MultiThreaded.XLL, or UNIVOPT.XLA).  If more than 

one add-in is required, you can open each .XLL (or equivalent .XLA) file in turn, one after 

another. 

For Excel 2007 and newer, please attach the .XLL files with names ending 

"_MultiThreaded.XLL", e.g. UNIVOPT_MultiThreaded.XLL etc.  These are multi-thread 

enabled add-ins. If you have a machine with dual-core or multiple CPUs, you can experience 

multi-fold speed increases when using the Multi-threaded version of the Universal Add-ins 

under Microsoft Excel 2007 and newer.  The speed increase during intensive calculations is 

almost directly proportional to the number of cores/CPUs used. 

Once the add-ins are attached, you can then load the sample spreadsheets supplied for the 

add-in (see section 10 below for the actual file names). 

Note to Excel specialists : the Universal Add-ins are fully .DLL & .XLL compliant. 

6. Real-Time Feeds 

The Universal Add-ins work with all the Real-Time data feeds which can communicate with 

Microsoft Excel e.g. Bloomberg, Bridge, Reuters, Dow Jones, S&P ComStock.  

Therefore, whenever the market prices (or rates) alter, the input cells which our add-in 

functions look at would automatically alter in real-time, and therefore our add-in functions 

will recalculate with the latest market values. 

The input cells for the Universal Add-ins can be linked with the real-time feed data items by 

simply "dragging and dropping" the quote from the real-time feed's screens into the add-in's 

Excel input cells (e.g. the input cells in the sample spreadsheets which are colored red). We 

recommend that the real-time feed provider shows you how to link their feed to a blank 

Excel spreadsheet.  You would use the exact same technique to link the real-feed to 

spreadsheets using the Universal Add-ins. 

7. Calling the add-in functions  

Each add-in's functions are only useable when the add-in is attached (see sections 4 & 5 above 

for instructions on how to attach the add-in).  You can still safely open your spreadsheet files 

containing the Universal Add-in functions without having the add-in attached, but these will 

only calculate after you have attached the Universal Add-in (Excel would display #NAME? 

until the add-in is attached). 

Since every time you exit Excel, the add-in detaches automatically, you need to attach it when 

you next start Excel.   This can be done automatically by using Excel’s Add-ins manager dialog 

to select which add-ins should be automatically attached / loaded each time Excel starts. 

To load the Excel Add-ins manager dialog : 
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a) Go to Excel’s Options dialog. 

b) Click "Add-ins". 

c) Then, on the bottom of the "Add-ins" screen, choose "Excel Add-ins" from the "Manage" 

drop-down box, and click "Go..." 

After the add-in has been attached to Excel, to call a function, you can use the "Insert Function" 

option (or the Function Wizard "fx" button). Our add-in functions would be in the Function 

Category : “mbrm Universal Add-in” 

Alternatively, the formula can be manually typed into a spreadsheet’s cell. 

8. FILE PROTECTION 

The sample spreadsheets supplied are protected to avoid accidental alterations.  The market 

data can be entered (in the red cells) and the answers seen in the black cells even with the 

spreadsheet being protected.   

The spreadsheets can be unprotected by the user, without requiring a password, by first 

selecting the sheet to be unprotected, and then using the "Review > Unprotect Sheet" 

command in Excel.  It is recommended to re-protect the sheet after the alterations are done 

using "Review > Protect Sheet". 

The exception to the above is that, during the trial period, a few sample sheets (e.g. the Bond 

Asset Swap Monitor sheet in USAEXAMP.XLS) are password protected. The password can 

be acquired from MBRM once the add-ins are fully licensed, thus you can customize the 

sheets to your needs (and see how we have implemented the sheet using our standard 

functions). 

9. MANUALS, DOCUMENTATION AND BROCHURES 

You can refer to these manuals and other documents by either : 

 Clicking the shortcuts in the "MBRM Universal Add-ins" program group (via Windows' 

"Start" button).   

 Or, opening the files in the installation directory, e.g. C:\MBRM. 

As a convention, MBRM uses the first letters of the function or file name to identify the 

add-in toolkit used (e.g. functions or files beginning with “UEA” would refer to the 

“Universal Exotics Add-in”).   

 manUOA.pdf    manual for UNIVOPT - Universal Options Add-in 

 manUEA.pdf    manual for UNIVEXOT - Universal Exotics Add-in 

 manUIA.pdf    manual for UNIVINT - Universal Interpolating Add-in 

 manUYA.pdf    manual for UNIVYLD - Universal Yield Add-in 

 manUSA.pdf    manual for UNIVSWAP- Universal Swap Add-in 

 manCMS.pdf    manual for UNIVCMS - Universal CMS & Swaptions Add-in 

 manULA.pdf    manual for UNIVLMM - Universal LIBOR Market Model Add-in 

 manUCA.pdf    manual for UNIVCONV - Universal Convertibles Add-in 

 UDAintro.pdf  Introduction to UNIVDRV - Universal Derivatives Add-in 

 manUDA.pdf    manual for UNIVDRV - Universal Derivatives Add-in 
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                       This is a combined manual for : 

  UNIVEXOT+ - Universal Analytical Exotics Add-in 

  UNIVFDIF  - Universal Finite Difference Add-in 

  UNIVGARCH - Universal Garch Add-in  

 manUVA.pdf    manual for UNIVVAR - Universal VaR Add-in "Value-at-Risk" 

 manUCDA.pdf   manual for UNIVCDRV - Universal Credit Derivatives Add-in 

 manURA.pdf   manual for UNIVRREP - Universal Risk Reporting Add-in 

 manFTR.pdf    manual for MBRM Futures/FRAs Arbitrage Module 

 manETO.pdf    manual for MBRM Exchange Traded Options System 

 Broch.pdf     Full brochure and order form 

 Feedback.pdf  Feedback from our clients 

 License.pdf   MBRM's License and Limited Warranty 

 OrderFrm.pdf  Order Form and Price List 

 PressExt.pdf  Press Extracts 

 RiskMgmt.pdf  Article on Development of Risk Management Systems 

 Remove.pdf    Instructions on how to deinstall the Universal Add-ins 

 SwapGrid.pdf  description of the MBRM Single/Cross-Currency Swap Grid 

 Version82.pdf New features in Version 8.2 of our Universal Add-ins 

 "MBRM Delta-Gamma, Garch VaR and beyond.pps" PowerPoint Presentation 

Supported users should visit the online Support/Discussion Forums and searchable 

Support Knowledgebase (located at the MBRM WEB SERVICE 

"http://www.mbrm.com/asp").  This will assist you in maximizing the benefit from 

using our Universal Add-ins and ensure you are one of the first to preview the latest 

models and enhancements. 

10. Names of the Sample Spreadsheets (workbooks) for Excel 

The sample spreadsheets (workbooks) have extensions .XLS.  These include multiple 

example sheets, including sheets which hold portfolios.  The market data are entered in the 

red cells with the answers shown in the black cells.   If you would like to see the "row & 

column headers" (i.e. the column labels A, B, C ... on the top of the sheet and the row 

numbers on the left of the sheet) you would use Excel's "View” ribbon and ensure 

"Headings" is ticked on. 

As a convention, MBRM uses the first letters of the function or file name to identify the 

add-in toolkit used (e.g. functions or files beginning with “UEA” would refer to the 

“Universal Exotics Add-in”). 

UNIVOPT - Universal Options Add-in : 

 UNIVOPT_MultiThreaded.XLL : Add-in "program" file (or equivalent UNIVOPT.XLA) 

 UOAexamp.XLS : Sample spreadsheet/workbook 

UNIVEXOT - Universal Exotics Add-in : 

 UNIVEXOT_MultiThreaded.XLL : Add-in "program" file (or equivalent UNIVEXOT.XLA) 

 UEAexamp.XLS : Sample spreadsheet/workbook 

 QUANTBSK.XLS : Quanto average rate and standard options on multi-currency baskets 

 UEA_Volatility_Tool.xls : MBRM Volatility Tool (including LGK and HL models) 

 MBRM_Cliquet_1_year.xls : Sample spreadsheet for path dependent exotic options 
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 UDA_exotic_equity_options_portfolio_v2a.xls : (for UNIVDRV & UNIVEXOT users) 

UNIVINT - Universal Interpolating Add-in : 

 UNIVINT_MultiThreaded.XLL : Add-in "program" file (or equivalent UNIVINT.XLA) 

 UIAexamp.XLS : Sample spreadsheet/workbook 

UNIVYLD - Universal Yield Add-in : 

 UNIVYLD_MultiThreaded.XLL : Add-in "program" file (or equivalent UNIVYLD.XLA) 

 UYAexamp.XLS : Sample spreadsheet/workbook 

UNIVSWAP - Universal Swap Add-in : 

 UNIVSWAP_MultiThreaded.XLL : Add-in "program" file (or equivalent UNIVSWAP.XLA) 

 EUR.XLS : Currency spreadsheet for Euros (compact "swapnote" format) 

 GBP.XLS : Currency spreadsheet for Sterling 

 JPY.XLS : Currency spreadsheet for Japanese Yen 

 USD.XLS : Currency spreadsheet for US Dollars (compact "swapnote" format) 

 USD_expanded.XLS : Normal (expanded) format currency spreadsheet for US Dollars.

  For additional currencies, the above files can be copied using "File > Save As" 

 USAexamp.XLS : Sample spreadsheet/workbook 

 USASENS.XLS : Portfolio sensitivity to parallel and non-parallel yield shifts 

 USAFXOPT.XLS : Foreign Exchange Forwards and exotic/plain vanilla Options 

portfolio  analysis.  Some features require UNIVVAR & UNIVDRV 

 SWAPGRD2.XLS : Single currency Swap Grid.  Entered market rates and the calculated  

  FRA & Swap values are displayed on the same spreadsheet 

 SWAPGRID.XLS : Single / Cross-currency Swap Grid 

UNIVINFLSWAP - MBRM Inflation Swaps / Index Linked Bonds Analyser: 

 mbrm_inflation_swaps_and_Index_Linked_Bonds.xls 

UNIVCMS - Universal CMS & Swaptions Add-in 

 UNIVCMS_MultiThreaded.XLL : Add-in "program" file (or equivalent UNIVCMS.XLA) 

 MBRMCMS.XLS : Sample spreadsheet/workbook 

 UCMS_CAPLET_SKEW.XLS : Caplet Implied Volatilities (with Smile / Skew) 

UNIVLMM - Universal LIBOR Market Model Add-in 

 UNIVLMM_MultiThreaded.XLL : Add-in "program" file (or equivalent UNIVLMM.XLA) 

 ULAexamp.XLS : Sample spreadsheet/workbook (including Multi-Currency and  

  Dual-Currency range accrual Bonds & simulations 

 ULA_PCA.XLS : Principal Component Analysis (PCA) and ULA_CALC_VC( )  

  which calculates historical volatilities and correlation matrices 

UNIVCONV - Universal Convertibles Add-in : 

 UNIVCONV_MultiThreaded.XLL : Add-in "program" file (or equivalent UNIVCONV.XLA) 

 UCAexamp.XLS : Sample spreadsheet/workbook 

UNIVDRV - Universal Derivatives Add-in : 

 A combined package of :  

         UNIVEXOT+  - Universal Analytical Exotics Add-in 

         UNIVFDIF  - Universal Finite Difference Add-in 

         UNIVGARCH - Universal Garch Add-in  

 UNIVDRV_MultiThreaded.XLL : Add-in "program" file (or equivalent UNIVDRV.XLA) 

 UDAexamp.XLS : Sample spreadsheet/workbook 
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 UDA_GARCH.XLS : Sample spreadsheet/workbook for GARCH estimation 

 UDA_exotic_equity_options_portfolio_v2a.xls : (for UNIVDRV & UNIVEXOT users) 

UNIVVAR  - Universal VaR Add-in (Value-at-Risk) : 

 UNIVVAR_MultiThreaded.XLL : Add-in "program" file (or equivalent UNIVVAR.XLA) 

 UVAexamp.XLS  : Sample spreadsheet/workbook 

 

            ** UNIVVAR and UNIVDRV users should also see sample spreadsheet : 

 UDAexamp.XLS, sheets "Garch VaR" and "Delta-Gamma VaR". 

UNIVCRD - Universal Credit Risk Add-in : 

 UNIVCRD_MultiThreaded.XLL : Add-in "program" file (or equivalent UNIVCRD.XLA) 

 UCRAexamp.XLS : Sample spreadsheet/workbook 

UNIVCDRV - Universal Credit Derivatives Add-in : 

 UNIVCDRV_MultiThreaded.XLL : Add-in "program" file (or equivalent UNIVCDRV.XLA) 

 UCDAexamp.XLS : Sample spreadsheet/workbook 

UNIVRREP - Universal Risk Reporting Add-in 

 UNIVRREP.XLA : Add-in "program" file. 

 URAexamp.XLS : Sample spreadsheet/workbook 

MBRM Futures/FRAs Arbitrage Module : 

 MBRMFTR.XLS : (requires UNIVSWAP to be attached) 

MBRM Exchange Traded Options System : 

 MBRMETO.XLS : (requires UNIVOPT and UNIVINT to be attached) 

MBRM Bond Futures "Cheapest To Deliver" (CTD) Analyser   

 MBRMCTD.XLS : (requires UNIVYLD to be attached) 

11. Portfolio handling  

Every Universal Add-in can handle portfolios.  This could be by way of : 

(a) Links to your in-house database.  See article "RISK MANAGEMENT SYSTEM 

DEVELOPMENT USING LOW COST ADD-IN TOOLKITS".  The article's file name 

is RISKMGMT.PDF and it is located in the installation directory (e.g. C:\MBRM). 

 

You should also see the article on the "MBRM Development Partnership Program" 

(MBRMDPP.PDF) located in the installation directory (e.g. C:\MBRM). 

and/or  

(b) Every Universal Add-in has Excel sheets already set up with portfolio and deal entry 

facility, e.g. : 

UNIVOPT - Universal Options Add-in 

 UOAexamp.XLS Sample spreadsheet/workbook. 

 See sheet : Portfolio 

  Portfolio2 

  Hedge 

UNIVYLD - Universal Yield Add-in : 

 UYAexamp.XLS Sample spreadsheet/workbook. 
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 See sheet :  Portfolio 

UNIVSWAP - Universal Swap Add-in : 

 USAexamp.XLS     Sample spreadsheet/workbook. 

 See sheets :  FRA-IRG 

  Swap Port 

  CapColFlr 

 

 USASENS.XLS Multi-Instrument Portfolio sensitivity  

  to parallel and non-parallel yield shifts. 

 

 USAFXOPT.XLS Foreign Exchange Forwards and  

  exotic/plain vanilla Options portfolio analysis. 

UNIVCMS - Universal CMS & Swaptions Add-in 

 MBRMCMS.XLS Sample spreadsheet/workbook. 

  See sheets :  CMS_CapColFlr 

  CMS_Quanto_CapColFlr 

UNIVCONV - Universal Convertibles Add-in 

 UCAexamp.XLS Sample spreadsheet/workbook. 

 See sheet :  Portfolio 

 

 See section marked "PORTFOLIO HANDLING" in the Appendix of  

 manual MANUCA.PDF 

UNIVDRV - Universal Derivatives Add-in : 

 UDAexamp.XLS Sample spreadsheet/workbook. 

 See sheets :  Garch VaR 

  Delta-Gamma VaR 

UNIVVAR  - Universal VaR Add-in (Value-at-Risk) : 

 UVAexamp.XLS Sample spreadsheet/workbook. 

 See sheet :  Mappings CFs & VaR 

UNIVCDRV - Universal Credit Derivatives Add-in : 

 UCDAexamp.XLS Sample spreadsheet/workbook. 

 See sheet :  Advanced functions & Portfolio 

MBRM Futures/FRAs Arbitrage Module : 

 MBRMFTR.XLS  Sample spreadsheet/workbook. 

 See sheet : Today's Trades 

MBRM Exchange Traded Options System 

 MBRMETO.XLS  Full trade entry and position keeping 

  for exchange traded and OTC options. 
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All the above spreadsheets can be enhanced by the user.  Indeed, many users of Excel simply 

call the Universal Add-in functions directly from their existing Excel spreadsheets in order to 

calculate their portfolio's sensitivities. 

12. Visual Basic / Visual Basic for Applications (VBA) Scripting 

The following files illustrate use of the add-ins in Visual Basic : 

(files located in the installation directory, e.g. C:\MBRM\VB6_Using_Declare) 

UCA_VB32.BAS UCDA_LIC.BAS UCDA_VB32.BAS 

UDA_VB32.BAS UEA_VB32.BAS UIA_VB32.BAS 

UOA_LC32.BAS UOA_VB32.BAS USA_VB32.BAS 

UVA_VB32.BAS UYA_VB32.BAS 

The following files illustrate use of the add-ins in VBA Scripting : 

(files located in the installation directory, e.g. C:\MBRM\VBA_for_Excel) 

UEA_VBA.BAS UIA_VBA .BAS USA_VBA.BAS 

As a convention, MBRM uses the first letters of the function or file name to identify the add-in 

toolkit used (e.g. functions or files beginning with “UEA” would refer to the “Universal 

Exotics Add-in”).   

Please see the Universal Options Add-in manual, MANUOA.PDF, section 4.29 

"CALLING THE FUNCTIONS FROM VISUAL BASIC / VBA". 

13. Visual C/C++ : Calling the add-in functions from C/C++ 

Please see the Universal Yield Add-in manual, MANUYA.PDF, section 4.11 

"CALLING THE FUNCTIONS FROM C/C++". 

Please also see the C/C++ sample file MBRMSAMP.CPP which is located in the 

installation directory (e.g. C:\MBRM\C&C++).  This is callable from either C or C++.  This 

illustrates how to call our add-ins from C/C++.  Header files (*.H) and Library link files 

(*.LIB) are also located in the installation directory. 

14. Fortran : files which illustrate use of add-ins from Fortran 

Please see the Universal Options Add-in manual, MANUOA.PDF, section 4.30 

"CALLING THE FUNCTIONS FROM FORTRAN". 

15. ActiveX (COM) objects 

The ActiveX (COM) implementations of our UNIVERSAL Add-ins are provided free when 

you acquire our standard add-ins.  The ActiveX (COM) objects are accessible from most 

Windows based development environments. 

The Windows based visual environment would list all our add-ins and function names (and 

parameter lists) in the environment's object window/browser.  Our ActiveX (COM) functions 

have exactly the same name and parameter definitions as our standard Excel and programming 
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language parameter definitions.  This conforms to our believe that it is in everyone's interest to 

have the exact same functions (with the same parameter definitions) irrespective of whether 

calling from a spreadsheet, traditional programming language or an ActiveX (COM) 

environment. 

When you install our add-ins, our ActiveX (COM) components are automatically registered 

and thus "expose themselves" to be called.  You will find a number of UNIV*_COM.DLL files 

(such as UNIVOPT_COM.DLL) in the install directory (e.g. c:\mbrm).  These are the ActiveX 

(COM) files which are registered in the Windows Registry by the Universal Add-ins setup 

program. 

In Visual Basic and VBA, the way to call the ActiveX (COM) objects is simply to define the 

class for the add-in, and then just call it.  Please see the COM example source files distributed 

with the Universal Add-ins (files ending "_COM.BAS") located in the installation directory, 

e.g. C:\MBRM\VB6_Using_ActiveX(COM)\.  
 

Windows based development environment have their individual ways to "register" which 

ActiveX (COM) libraries a user wishes to access, e.g. : 

 In Visual Basic, you need to ensure that the used Universal Add-in is "ticked" (i.e. chosen) 

in VB's "Tools > References" menu. 

 

The posting in our UNIVSWAP online support forum, with subject "How do I call your 

ActiveX (COM) objects from Visual Basic or VBA ?", might be helpful since it 

compares the three different ways to call our add-ins from Visual Basic / VBA. 

 In Delphi, to call these functions, you would use the "IMPORT TYPE LIBRARY" from 

the Delphi menu to register the UNIVOPT_COM.DLL.  In Delphi, when you import a type 

library, it generates a separate .TLB file for each add-in.   The contents of the .TLB file will 

also list all the functions imported.  The USES command in your .PAS file would then 

mention the add-in name. 

The posting in our UNIVYLD online support forum, whose subject is "Installing UNIVYLD 

on IIS Server and calling it via ASP when Excel not installed", might be helpful if installing 

our add-ins on a system without Excel since it shows how to enter license number from your 

own code. 

16. Calling the Universal Add-ins from C# 

To call the Universal Add-ins functions from C#, you can use either the DLL import function, 

or the C# (CS) wrapper libraries that are included with the Universal Add-ins package. 

We strongly recommend that you use the DLL import function ("DllImport( )") because it calls 

our C/C++ .DLL libraries directly and avoids the need for an extra function layer which 

converts the arrays from C# arrays to native arrays as used by the add-ins (and back again). 

This method will thus give you the best performance from C#.  Example code demonstrating 

this method can be found in sub-folder “C#_Using_DllImport” of your Universal Add-ins' 

installation folder. 

The C# (CS) Wrapper libraries of the Universal Add-ins on Windows are included as part of 

the standard Universal Add-ins download. 
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The C# Wrapper of the UNIVERSAL Add-ins is an extra layer (“wrapper”) on top of the core 

libraries of UNIVERSAL Add-ins.  Details about how to call the Universal Add-in functions 

from C# via the provided C# wrapper are described in 

UniversalAddinsC#_InstallationGuide.pdf that can be found in the sub-folder " 

C#_Using_Wrapper" of your Universal Add-ins' installation folder.  

17. Java Native Interface (JNI) of the UNIVERSAL Add-ins 

The Java Native Interface (JNI) of the UNIVERSAL Add-ins is an extra layer (“wrapper”) on 

top of the core libraries of UNIVERSAL Add-ins.  Details about how to call the Universal 

Add-in functions from Java via the provided JNI wrapper under Windows and UNIX are 

described in UniversalAddinsJNI_InstallationGuide.pdf that can be found in the sub-folder 

"Java_Native_Interface_(JNI)" of your Universal Add-ins' installation folder.  Extensive 

sample source code that illustrates how the Universal Add-ins can be called from Java can also 

be found in that folder. 

18. MBRM's technical support facilities 

To increase the speed in answering your questions, as well as to enable us to focus our 

support efforts on questions which are not already answered on our online 

Support/Discussion forums (or in the manuals), please note : 

1)  We recommend you initially search the online support/discussion forums and searchable 

support knowledgebase of the MBRM Web Service: 

http://www.mbrm.com/asp 

Supported users have free access to this to assist in maximizing the benefits from using 

our Universal Add-ins and ensure they are one of the first to preview the latest models 

and enhancements. 

You may find that your question is already answered in either the above or the locally 

installed Acrobat PDF format manuals (MAN*.pdf) which are installed automatically on 

your machine when you install our add-ins.   Please see the "Quick Start Guide 

(README.PDF)" section 9 :  

"9. MANUALS, DOCUMENTATION AND BROCHURES" 

The "QUICK START GUIDE" (README.PDF) is very useful as an initial "roadmap" 

to the UNIVERSAL Add-ins. You can refer to it by either :  

 Clicking the shortcut "Quick Start Guide (README.PDF)" in the "MBRM 

Universal Add-ins" program group (via Windows' "Start" button). The shortcuts can 

also be used to view the manuals, brochures, price list, discount schemes, order 

form, press extracts, client feedback, background article on risk management system 

development, Visual Basic and C/C++/Java/C# examples etc. 

 Or, using Microsoft Word to open the file README.PDF (in the installation 

directory, e.g. C:\MBRM) 

2)  If your question is still unresolved, please e-mail MBRM's 24x7 Support Service :  

support@mbrm.com 

http://www.mbrm.com/asp
mailto:support@mbrm.com
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(always quoting your support invoice number and your Machine ID number as generated 

by our UNIVERSAL Add-ins). 

It is sometimes helpful if you e-mail us one of our sample spreadsheets which shows the 

problem occurring together with all the input parameters used. Experience has shown 

that using our sample spreadsheets can greatly assist in solving issues arising when 

calling from your own spreadsheets (especially due to the extra results returned by our 

sample spreadsheets). This might also clarify whether the problem is data related.  

     

E-mail attachments should preferably be compressed/zipped to reduce their size and 

increase reliability during transmission.  

3)  If your problem is still unresolved, you can call technical support on +44 20-7628 2007 

(quoting your support invoice number and your Machine ID number as generated by our 

UNIVERSAL Add-ins).  

Enhanced support : 

Training and Consultancy sessions using Web Conferencing 

MB Risk Management uses Web Conferencing software to introduce our products and 

services as well as provide training and consultancy sessions remotely.  This allows us to 

show the capabilities of our Universal Add-ins without our clients facing the hassle and 

expense of taking on-site visitors, yet still maintaining two way interaction. 

With Web Conferencing, one of our technical representatives would be able to talk and guide 

you through any our Universal Add-ins at a pace suited to you. 

A charge will apply for this service. 
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